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Was Your Data Included in Recent Security Breaches?
So far in 2019, I’ve received four email notifications from
the Have I Been Pwned service, each one alerting me that I
was one of tens or hundreds of millions of people whose data
was stolen in a security breach. In fact, if I add up all the people
whose data was compromised just in those four breaches, the
total comes to 1,588,640,494. That’s right—over 1.5 billion
records of data, including names, email addresses, passwords,
dates of birth, employers, genders, geographic locations, IP
addresses, job titles, phone numbers, and physical addresses.
Such laxity and malfeasance are incredibly distressing, but these breaches are all in the past, and there’s
absolutely nothing you or I or anyone else can do about that exposed data now. However, any of that
data—particularly passwords—could be used against you, so it’s essential to make sure that you’re as
protected as possible from such attacks.
The best thing to do is to make sure that you’re using a password manager like 1Password (TidBITS
members get six months free!) or LastPass to create a strong, unique password for every Web site. That
way, even if one site is compromised, as seems to happen every other week now, your accounts on other
sites won’t be vulnerable (and yes, this happens; it’s called credential stuffing). According to one 2017
survey, as many as 25% of users reuse the same password across a majority of their accounts, and over
80% of people have reused the same password across two or more sites.
If you fall into that 25%, or someone close to you does, I strongly recommend Joe Kissell’s recently
updated Take Control of Your Passwords, Third Edition. It’s
one of Take Control’s best-selling books because it explains
everything you need to know about making your online
accounts more secure and simultaneously easier to access. And
if you or someone you know has ever said, “But I don’t have
anything to hide,” read Joe’s Take Control of Your Online
Privacy, Fourth Edition, which he just updated with essential
advice on dealing with all the latest threats. (It explains what
you do have to hide.) Each book costs $14.99, but you can buy
both together for just $20.
One last thing: Take a minute and
search for your email address on the
Have I Been Pwned site. It will tell you
how many breached sites contained your
address. (Don’t worry, the site is safe to
use; the email address is never stored.)
My address, which I’ve used broadly and
consistently for many years, has been
caught up in 22 breaches.
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Macs & macOS
Prepare for Apple Dropping Old Media Formats with the IINA Video Player

by JOSH CENTERS
Unless you follow all the links in our Watchlist items, you may have missed this ominous message in Apple’s release notes for Final Cut Pro 10.4.6
(see “Final Cut Pro X 10.4.6, Compressor 4.4.4, and Motion 5.4.3,” 22 March 2019):
Detects media files that may be incompatible with future versions of macOS after Mojave and converts them to a compatible format.
That’s right, Apple is dropping support for some media formats in the next major release of macOS because the old QuickTime 7 framework
isn’t 64-bit friendly. Here are some of the more common ones that were previously supported by third-party software relying on the QuickTime 7
framework:
• 3ivx MPEG-4
• Cinepak
• DivX
• Flash Video
• Perian collection of codecs (such as Microsoft MPEG-4, DivX, 3ivx, VP6, and VP3)
• RealVideo
• Windows Media Video 7, 8, 9
• Xiph.org’s Theora Video
Thankfully, the industry has now largely settled on H.264 and H.265. But if you’re used to dealing with transcoding video (or let’s be honest,
downloading it from shadowy sources), you’re probably wincing right now. And even if you aren’t, you may very well have old videos in obscure
formats, as might have happened with video taken with a flip phone.
There are many open-source video players, the most popular being VLC, but there’s one that’s both better and Mac-exclusive: IINA. It’s free, it’s
open-source, it’s built for the Mac (written in Swift even!), and it hit 1.0 at the end of 2018 (I’m reviewing version 1.03). What’s not to love?
Building on MPlayer, mpv, and FFmpeg
In the 2000s, MPlayer (not to be confused with the media player for Windows or the gaming service from the late 1990s—yes, I’ve used all
three) was the gold standard for video playback in the open-source world. That project has mostly been abandoned and superseded by mpv, a Unix
command-line video player that offers unmatched performance and extensibility.
What does this have to do with IINA? Well, mpv is the engine that drives IINA. If you fancy yourself a Terminal wiz, you can easily install mpv
on your Mac any number of ways, with my favorite being Homebrew. You’ll have to run mpv from Terminal, which offers some advantages, but
for most of us, those don’t outweigh the convenience of a graphical interface. Thankfully, the installation of IINA doesn’t require anything fancy; just
open the disk image and drag the app to your Applications folder.
Since mpv is based on the free software project FFmpeg, it supports all the file formats and codecs that FFmpeg can handle, which is just about
everything you can imagine, including the formats Apple is discarding.
The astute among you will point out that VLC is also based on FFmpeg, so why bother switching? Well, they’re both free, so it’s not an either/or
situation, but I’ll let you see what both look like in action. IINA is on the left, VLC on the right:
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While VLC has to provide a cross-platform interface for the Mac, Windows, Linux, and even OS/2, IINA is made solely for the Mac, so as a Mac
user, you’ll be immediately familiar with its conventions. For instance, you’ll probably recognize the Apple picture-in-picture icon, and clicking the
gear icon displays all the key video settings in one place.

Favorite IINA Features
I’m sure if I compared IINA and VLC’s features, VLC would win. It has been in development for many years, while IINA just hit 1.0. But IINA
offers all the essentials and then some, and most importantly, Mac users will have no trouble finding them. If you’ve ever felt overwhelmed by VLC,
launching IINA is a breath of fresh air.
But I don’t want to give the impression that IINA is lacking in features. It still offers more than you’ll likely ever need. Here are three of my
favorites.
Picture-in-Picture
Since IINA is made for the Mac, it supports the native macOS picture-in-picture feature, introduced in 10.12 Sierra. Just click the
picture-in-picture icon to shrink the video into a miniature window that anchors to one of the four corners of the screen and stays on top. You could
also choose Video > Float on Top if you just want to keep the video on top, but the system picture-in-picture feature works well for watching a video
while you’re working.
YouTube Player
Another neat feature of IINA is that it can play YouTube videos. Copy a YouTube URL and choose File > Open URL in New Window and
paste the URL. (VLC can do this as well.)
What’s the upside of playing YouTube videos in IINA instead of the browser? For starters, it makes it easy to play videos picture-in-picture. And
while it’s difficult to resize a YouTube video within a browser window, IINA makes it as easy as resizing a window. And of course, IINA lets you
control YouTube videos with your media keys.
Sure, there are ways to do all of that inside a browser, but IINA is an all-in-one solution.
Music Mode
It seems like everyone streams their music these days, but many of us still have gigabytes of MP3 and AAC audio files. Unfortunately, there aren’t
many simple music players for the Mac—iTunes has largely crowded them out, even though it has been a hot mess for years.
Most video players can also play audio, but it’s usually clumsy. The IINA developers did something clever and implemented Music Mode. You
can invoke it by choosing Video > Music Mode, but it also activates automatically if you open a music file or a folder containing music files.
What’s different about Music Mode? The display window shrinks down to show just the album art and playback controls. You can optionally
hide the art and show the playlist if you wish. It’s a nice, lightweight music player if you’re fed up with the bloat of iTunes.
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Bad Apple #4: Reminders Stinks at Sorting
by ADAM ENGST
I’ve been remiss in keeping up with my Bad Apple column, which exists to document aspects of
the Apple experience that are incontrovertibly wrong and have an obvious solution. But it’s time for
another one because I’ve just figured out one of the reasons that Apple’s Reminders app has been
getting on my nerves lately: the silly thing still can’t sort list items to save its life. Bad Apple!
Reminders originated with iOS 5 and OS X 10.8 Mountain Lion, when Apple split iCal into
Calendar and Reminders. It was a simple app then, and it has remained so across years of iOS and
macOS updates. Unfortunately, when it comes to sorting list items in Reminders, “simple” seems
to mean “embarrassingly underpowered.”
Only Manual Sorting in Reminders in iOS
In the iOS version of Reminders, eight major updates later, you still cannot sort
Reminders lists in any way other than manually. And even that feature doesn’t
merit a mention in Apple’s documentation of Reminders. Bad Apple!
Let me rectify that omission. When in a list, you can tap Edit and then drag
reminders around by their handles to rearrange them.
It’s not as though the concept of sorting is foreign to iOS. In the Settings app,
both Contacts and Notes offer sort options, and when you’re in the Music app’s
Library, you can sort within the lists of albums, playlists, and songs.
The only justification I can imagine is that Apple doesn’t think anyone will use
Reminders to store so many items that sorting would become useful. It’s true—if
you never put more than about ten items in a Reminders list, you can probably
see them all on one screen without scrolling.
Single List Sorting in Reminders in macOS
Although Reminders predates the so-called “Marzipan” apps that Apple ported
from iOS to macOS in macOS 10.14 Mojave (News, Home, Voice Memos, and
Stocks), we should have realized that it foreshadowed just how lousy those apps
would be.
The Mac version of Reminders is more capable than the iOS version—not that
it’s a high bar—and notably, it does allow some sorting. Choose View > Sort By,
and you’re presented with five options: Manual, Due Date, Priority, Creation
Date, and Title. That’s good, right?
Not so fast. As a Mac user, I naturally assumed that each list in
Reminders had its own sort order. If I have a to-do list where I’m
prioritizing tasks, I’d want to sort by Priority. And if I have a list
of article ideas, I’d want to sort them by Title. Manual would be
useful for a process list, where I want to go through a particular
set of tasks in order. Due Date is obviously what I’d want for a
task list where the completion date is paramount, and I’m sure
there are uses for Creation Date even if none spring to mind at the moment.
But no, Reminders supports only a single sort order that applies to every one of your lists. This is what threw me since I’d be in a list and notice it
wasn’t sorted in a useful manner, so I’d change the sort order. Then, sometime later I’d be in a different list and notice that it too was sorted wrong.
Since I have a variety of list types, any change I made to the sort order for one list was bound to mess up another list. Bad Apple!
At least Apple acknowledges in its documentation for the Mac version of Reminders that sorting is possible, and while the company doesn’t
cop to the fact that the sorting applies to all lists, it does warn that, unlike the reminders and lists themselves, whatever sort order you set will not sync
to any other Macs or iOS devices where you use Reminders.
Alternatives to Reminders
There’s only one reason I actually like Reminders: its Siri integration (when it works—see “Bad Apple #3: Reminders Doesn’t Listen to Siri,” 6
April 2018). Things to do pop into my head throughout the day, and if I can use Siri to make myself a reminder, they’ll get done.

7
Given Apple’s recent financial woes (only $11.56 billion in profit last quarter—see “iPhone Sales Kept Sinking in Apple’s Q2 2019,” 30 April
2019), I worry that the company lacks the necessary resources or fortitude to find a student from Cupertino High School to add per-list sorting to
Reminders. Syncing such sort orders through iCloud is undoubtedly even harder, but maybe Apple already has an undergraduate intern who could
puzzle through CloudKit to add such a feature. Apple’s professional programmers haven’t figured this out in nearly 8 years, but I’ll bet a few kids
could do it in a weekend. It’s sorting, not rocket science.
Until Apple gets its act together, I’m going to look for alternative apps that tap into the Reminders database. That way I can continue to use Siri to
create reminders without suffering with the actual Reminders app. Both BusyCal and Fantastical can access and display the contents of Reminders,
let you choose which Reminders lists to show, and try to sort intelligently (with dated items sorted by date and undated items sorted by title).
Fantastical even lets you show reminders in its menu bar-based window, which you can tear off and position anywhere onscreen. But neither is really
focused on reminders, so I’ll have to see if their approaches work for me.
As far as standalone apps go, the three I’ve found so far that run on both the Mac and iOS and that connect to the Reminders database are 2Do,
GoodTask, and Memento. 2Do is free for iOS with a variety of in-app purchases; its Mac version costs $49.99. GoodTask is free for iOS and costs
$19.99 on the Mac. And Memento costs $3.99 for iOS and offers only a 0.1 beta of a Mac version so far. I haven’t tried any of them yet.
Should You Pay For Apple News+? Warning: It Has Issues
by JULIO OJEDA-ZAPATA
Of the services Apple revealed at its 25 March 2019 special event, only one—the
Apple News+ digital magazine service, a paid add-on to the company’s free News
app—was actually made available (see “Apple News+ Debuts With Magazines,
Newspapers, and Web Sites,” 25 March 2019).
This was great news for information junkies who gained access to a treasure trove of
additional content—primarily magazines, with a handful of newspapers and news
Web sites thrown in. At $9.99 per month—with multiple members of a Family
Sharing household able to maintain their own reading preferences for that single fee—
Apple News+ will strike many as tempting.
However, the service has omissions, compromises, and a few rough edges, and some
of these might prevent you from subscribing. It’s easy to check for yourself—the first
month is free—but I recommend setting a reminder to cancel the subscription before
you’re charged in case you don’t find it meets your needs.
Some Content Is Missing
Apple News+ seems like a bargain because it provides access to top publications like the New Yorker and the Wall Street Journal that cost more
than all of Apple News+ if procured individually elsewhere.
But what is it missing? TidBITS reader Duane Williams noted that the version of the New Yorker offered via Apple News+ is missing some of the
features found in the print magazine and on the magazine’s own site. These largely New York City-specific omissions may not trouble you—the
main columns and articles seem to be present—but know that you’re not getting exactly what you would in print. (And as reader Marilyn Matty,
who worked in advertising for many years, explains in that discussion and one other, many magazines produce multiple editions even in print, so
there may not be a single canonical version.)
The Wall Street Journal is an even more extreme example of this “curation.” On the face of things, it offers only a selection of its articles via Apple
News+. Other content is supposed to be lurking below the surface, and available via searching, but articles I’ve wanted to read have sometimes
proven elusive. And those are just the ones that I knew to search for. And the accessible archive will reportedly contain only 3 days of content from
the newspaper.
However, TidBITS reader Doug Miller found a clever way to search better (the Apple News search is weak at best) and to access at least some
articles that are older than 3 days, though not the full archive. He wrote:
You can go to the WSJ.com Web site in Safari in iOS, open any article there, and if it is for subscribers only, hit the share icon, share to Open in
Apple News, and it will open the full article in Apple News if you are a News+ subscriber.
Is Apple News+ a Good Value?
Not necessarily. As we noted in our earlier coverage, public libraries offer online versions of magazines for free via digital partners such as Flipster
and RBdigital. But whether you regard these as acceptable alternatives to Apple News+ depends on which magazines you like to read.
I was excited about Apple News+ at first. After doing an inventory of my preferred magazines, however, I realized it might be a waste of money.
Many of my favorite titles, such as Macworld and Wired, are available to me using RBdigital via the St. Paul Public Library or at the
Minneapolis Public Library. Others, including Fortune, Fast Company, and Bloomberg Businessweek aren’t—but I can get much of their content

8
for free on their Web sites. All public library systems are different, so check with your library to see what it offers in terms of digital magazine services
and how they line up with your preferences.
Libraries aside, the real question is if you’re spending more than $120 per year on periodicals. In our recent survey, only about 25% of TidBITS
readers said they spent more than that each year (see“Survey Responses: Apple Music and Apple News+,” 8 April 2019). If you’re getting all you
want to read for less money, there’s little advantage to Apple News+.
In fact, for many news junkies, the News app’s plethora of free news content might be more than sufficient without all the additional titles
available in Apple News+. Do you have time to read more than you’re reading now?
A Suboptimal Reading Experience
An advantage of Apple News+ over other digital magazine services is formatting. Many publications on the service have been reworked and made
adaptable for a range of Apple’s devices, from a 27-inch iMac to a 4-inch iPhone SE. Some titles even have animated covers.
However, many titles—about half of the roughly 250 magazines available—have not received this retooling. Time and time again, I found issues
that provided little more than digital snapshots of their original printed pages, which are all but impossible to read on smaller screens.
Even reformatted content looks lousy on the Mac, but that’s a general problem with the Mac’s awkward “Marzipan” News app ported from iOS.
It’s a terrible Mac app, with no attention to the sort of conventions and user-interface niceties Mac users expect.
Beyond the comparison with other digital magazine services, Apple News+ isn’t entirely successful in expanding from a collection of articles to an
interface for reading a coherent magazine. Although most magazines seem to have a table of contents, at least the New Yorker’s editors chose, oddly,
to rearrange the table of contents to focus on feature articles, thus confusing the structure of the magazine. Others may have done so as well.
Speaking of which, when you’re in a magazine, the News app doesn’t help you understand where in the issue you are in terms of what articles
came before or come next, or how much you have left to read overall. (There is a bar on the right edge of each article that shows roughly where inside
an article you are.) Such confusions don’t exist when reading unrelated individual articles in Apple News as it has been up to this point, but they’re
disconcerting when you expect the full magazine experience.
Finally, magazines in Apple News+ still have ads—you didn’t think you were going to get away without ads, did you?—and in some cases, like
Runner’s World, they can be difficult to distinguish from the reformatted article leads. And if you were interested in a shoe ad, don’t bother tapping
or clicking to learn more—it won’t do anything.
Where Are My Favorites?
Apple News+ is derived from Texture, a digital magazine service that Apple bought a year ago (see “Apple Acquires the Digital Magazine
Service Texture,” 12 March 2018). Texture fans might find Apple News+ a bit confusing and possibly disappointing.
For instance, Texture collected users’ favorite magazines—both current and back issues—in a My Library section for convenient access. Apple
News+ has no such thing. Apple News+’s My Magazines area does something different, showing current and recent reads regardless of whether these
are users’ favorites. I have no interest in Elle, but it’s now shown annoyingly at the top of my app’s main screen because I happened to read an Elle
story that looked interesting.
Apple News+ has a workaround, but it’s clunky; go to a magazine’s homepage within the app, tap the heart-shaped “like” button at the top, and
the magazine gets added to the app sidebar along with items in the free portion of the News app. That’s fine, but this approach does not scale well.
The sidebar quickly becomes long and cluttered.
By the way, Apple is shutting down Texture on 28 May 2019.
Will Apple News+ Help Publishers?
Some might subscribe to Apple News+ as a way to help magazine and newspaper publishers in what has been an increasingly embattled
journalism industry. As a reporter and Web producer at a major metropolitan newspaper, I thank you for that impulse!
However, Apple News+ isn’t likely to help publishers in a major way. Most seem to see it as a necessary evil that may generate some revenue and
that they hope will increase direct subscriptions. Over at Digiday, one publisher was quoted as saying “You’re not generating subscribers [with Apple
News+], you’re getting revenue. It’s going down a rabbit hole.” Another was even blunter: “Their pitch was we are going to take over the news
business. Join us or get left in the dust.”
Direct subscriptions are a far more effective way to support your favorite publications. Otherwise, Apple takes a cut of your $9.99-per-month
payment, and what’s left has to be shared among all the Apple News+ publications you read. It will be a pittance.
Direct subscriptions needn’t be expensive, either; a New York Times digital-only subscription was just $1 per week the last time I checked, and I
got a similar $1-per-week deal from the Washington Post through June. And again, how much time do you really have to read ephemeral content?
The Bottom Line
Apple News+ needs work.
Current and would-be subscribers deserve a more complete accounting of what they get and don’t get for their money—that’s a little thing we in
the journalism business call transparency.
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It would be nice if the full catalog received a digital revamping for comfortable reading on a variety of display sizes, but that’s largely up to the
magazines, not Apple. Such a move is important to set Apple News+ apart from free services available via the public libraries you support with your
tax dollars; those services are a bit crude.
And while an Apple News+ subscription may be better than nothing when it comes to supporting the struggling journalism industry, it’s far from
a panacea.
How to Cancel Apple News+
by JOSH CENTERS
A month has passed since Apple launched Apple News+ (see “Apple News+ Debuts With Magazines, Newspapers, and Web Sites,” 25 March
2019). If you signed up for the free trial but aren’t enthused about the service or can’t find the time to read more (see “Should You Pay For Apple
News+? Warning: It Has Issues,” 9 April 2019), you’ll want to cancel before Apple charges you.
Jeff Carlson told us that News asked him if he wanted to continue his free trial, and even though he thought he said no, it automatically renewed
and charged him $9.99. We aren’t in a position to test this again to know exactly what’s happening, but suffice it to say that a manual cancellation is
safest.
Note too that when you cancel a free trial, your access to Apple News+
ends immediately. If you’re canceling a paid subscription, your access
continues through the end of the billing period.
Cancel Apple News+ in iOS
You can easily cancel in the iOS News app with a few quick steps:
1. Open News,
2. Tap the Following button in the lower-right corner to bring up the
Following tab.
3. Scroll down to the bottom and tap Manage Subscriptions.
4. Tap Cancel Free Trial or Cancel Subscription.
5. When prompted, tap Confirm.
Alternatively, you can cancel from within the App Store app. Tap this link
in iOS to jump directly to the Subscriptions screen in the App Store, where
you can select Apple News+ and cancel. Or, in the App Store app, tap your
avatar in the upper-right corner, tap Manage Subscriptions, select Apple
News+, and then tap Cancel Free Trial.
Cancel Apple News+ on a Mac
To cancel your subscription from a Mac, follow these steps:
1. Open the News app.
2. Choose File > Manage Subscriptions. News launches the App
Store app and opens a dialog showing your subscriptions.

3.Click Edit to the right of Apple News+.
4.Click the button for Cancel Free Trial or Cancel Subscription.
5.Click Confirm.
If you prefer, you can cancel from inside iTunes. Click this link to
jump directly to the Subscriptions screen in iTunes, or choose Account
> View My Account, scroll down to Subscriptions, and click Manage.
From there the process is the same as in the App Store app.
We have to give Apple credit—the company provides lots of ways to
manage your subscriptions!
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What Does the T2 Chip Mean for Mac Usage?
by GEOFF DUNCAN
Beginning with the iMac Pro in December 2017—and continuing with Mac mini,
MacBook Air, and MacBook Pro models introduced in 2018 and onwards—Apple has
packed Macs with its own homegrown T2 chip. Like its predecessor, the T1, the T2 is
designed to shift responsibility for security-critical aspects of Mac hardware out of the
hands of the Mac CPU and traditional computing components—where they can be
subject to hacks and malfeasance—into a “secure enclave,” a separate environment
inaccessible to hacks, malware, and even hardware-based security risks. Even if macOS
were somehow completely “pwned” by a security flaw or attacker, the critical functions and
data handled by the T2 would be completely unaffected.
These days, it’s safe to say most technology users are interested in more security, rather than less, so the benefits of the T2 seem clear, if decidedly
nerdy. But that doesn’t mean a T2-equipped Mac is the right choice for every Mac user right now—even those who want to be as secure as possible.
Why Does Apple Need Security Chips?
It’s no secret Apple’s hardware group has been on a roll for the last several years: it currently makes five processor lines (the A, H, S, T and W
chips) that power everything from iPhones and iPads to the Apple Watch and AirPods. So it’s not surprising Apple would bring its own silicon to
the Mac to enable Apple-exclusive features.
The company introduced the T1 in late 2016 to handle the fingerprint processing for Touch ID sensors in the first Touch Bar-equipped
MacBook Pros, and it also helped lock down sensitive components like the built-in microphones and cameras. Further, the T1 took over the System
Management Controller (SMC), which is responsible for heat and power management, battery charging, and sleeping and waking the Mac. Finally,
the T1 determines if macOS is running on actual Apple hardware.
The T2 picks up from there, with four major capabilities:
• It takes over all access to built-in solid-state drives, enabling real-time encryption and decryption so your data is never stored in the clear
• It provides the processing power that lets you invoke Siri with “Hey Siri”
• It offers image enhancement for built-in FaceTime HD cameras
• It can optionally lock down a Mac’s boot process—so if someone were to steal your Mac, they wouldn’t be able to start it up using an external
drive and steal your data
The T1 and T2 can do all these things because they’re basically separate computers with their own isolated memory and storage: they’re ARM
chips running Apple’s bridgeOS. The T2 is based on the A10 processor that shipped in the iPhone 7, and bridgeOS derives from Apple’s watchOS.
In some ways, the T1 and T2 act as independent co-processors, enhancing performance by handling common tasks for the Mac and enabling the
CPU to focus on other things. But in other ways, they significantly beef up security, since they offer a fully independent system that remains secure
even if macOS is compromised.
What Does The T2 Do For You?
Apple has published an overview of the T2 chip spelling out some of its technical
details, but here are the main points:
• Secure Boot: The T2 ensures all components of the startup process—including
firmware, the kernel, any kernel extensions, and bootloaders—can be
cryptographically verified as trusted by Apple before booting. The idea is to
prevent the Mac from being started up on compromised low-level software,
thereby exposing users’ data. Secure Boot also covers Recovery Mode, Diagnostics
mode, and Internet Recovery mode. By default, Secure Boot trusts only software
signed by Apple or—get this—signed by a Microsoft certificate to authenticate
Microsoft bootloaders. That means Boot Camp installations of Windows 10 on
the internal SSD have all the benefits of Secure Boot, but anything else—like
Linux—is currently out in the cold. Macs with T2 chips also have the Startup
Security Utility available in Recovery Mode. Users (with a valid admin password!)
can set a firmware password and/or downgrade some Secure Boot functionality.
However, the No Security setting doesn’t necessarily enable untrusted operating
systems to start up using the internal SSD, since they’d have to support the T2 as
a storage controller (sorry, Linux). Using other operating systems seems to be

Secure Startup Utility is available in T2-equipped Macs
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possible only from external drives, and they gain virtually none of the benefits of the T2, including fingerprint authentication.
• Encrypted Storage: The T2 enables on-the-fly encryption and decryption of data on a Mac’s built-in solid-state drive. The encryption uses
the same technology as FileVault and requires a valid password to boot up. Because the T2 is a separate system, it can enforce delays on failed
password attempts: there’s a limit of 30 password attempts on the Login window or in Target Disk Mode, with a 1-minute delay on each
after 14 failures. More attempts are available in Recovery Mode and FileVault recovery (including iCloud recovery), but the delay can grow to
as much as an hour between allowed password attempts. This sort of delay makes brute-force password attacks impractical. However, don’t
expect to see the T2’s on-the-fly encryption on anything but internal SSDs: Macs with traditional hard drives (some new iMacs still have
them!) will probably never see this benefit. External drives don’t gain this protection, either.
• Touch ID: On the MacBook Pro and MacBook Air, Touch ID works much as it does on iOS devices: you get five tries to match a
fingerprint, and the odds of any random fingerprint matching one stored in Touch ID are about 1 in 50,000. (So if you set up 5 fingerprints,
roughly 1 in 10,000 will unlock your Mac. That’s a lot of grubby hands on your Mac.) The Mac will still require a password at startup if it
hasn’t been used in 2 days, or if no password has been used in roughly a week. (The real criteria are that a password hasn’t unlocked the Mac
in 6.5 days and no fingerprint has unlocked it in 4 hours.)
Hush, Now: All T2-equipped MacBook Pro and MacBook Air models have a hardware disconnect for the built-in microphone whenever the lid
is closed. That means even if some malware were able to take control of your microphone and surreptitiously listen or record through it, the
microphone is essentially physically unplugged from the Mac when you close the lid. The same can’t be said of headsets, external microphones, or
other audio gear, though. There’s no hardware disconnect for the FaceTime HD cameras: closing the lid blocks them effectively.
Downsides of the T2
For most Mac users, the benefits of the T2 are clear, particularly for notebook users who take their Macs with them wherever they go. If your new
MacBook Air is stolen, the T2 offers decent assurance that sensitive data—like email, passwords, credit card numbers, social media accounts,
super-secret projects, or those pictures—won’t fall into the wrong hands.
The T2 isn’t without trade-offs, however:
• Less Repairability: The T2 chip requires technicians to run a proprietary diagnostic tool to replace certain components like flash storage, the
Touch ID sensor, and the main logic board, which means repairs or replacement of those components can only be done at Apple Stores or by
Apple Authorized Service Providers. Most Mac users will never need to replace those components, but it’s yet another way Macs are
becoming less repairable.
• Goodbye, NetBoot: T2-equipped Macs can’t boot from network volumes, which could be a serious issue for organizations and schools that
still rely on the now-deprecated NetBoot. If you need NetBoot, take note: Apple’s recently refreshed iMac line does not have the T2 chip (see
“Apple Boosts iMac Performance with Faster Multi-Core CPUs,” 19 March 2019).
• Data Recovery As-Good-As Impossible: That on-the-fly encryption and decryption the T2 chip provides for the SSD means the T2 is the
only way to get data off the internal drive. If the T2 is damaged or becomes inoperable, your data is inaccessible, even to top data forensics
experts, so have a solid backup strategy in place—check out Take Control of Backing Up Your Mac, Third Edition for all you need to
know in that department.
• Linux & Older Windows Boot Issues: Lots of software developers—particularly Web developers—prefer to work in Linux or other
operating systems, even if they own a Mac. T2-equipped Macs can only boot Linux or versions of Windows prior to Windows 10 from
external drives after disabling the T2’s Secure Boot feature. If you need to run one of these operating systems, get used to doing it in a virtual
machine. If you must run one of these systems on “bare metal,” a T2 Mac is not for you.
So What’s With These Audio Problems?
Since the introduction of the iMac Pro—and continuing with newer T2-equipped Macs—users have reported occasional audio glitches: little
clicks, pops, or bursts of noise that seem to happen at irregular intervals. They occur with both audio playback and audio recording, and can happen
using any app, whether listening to Apple Music, watching a video on YouTube, playing a game, or—uh oh!—playing a hot DJ set at a party or
recording a live symphony orchestra.
The problem seems most common with USB-connected audio devices—whether consumer-grade headsets, podcaster-level microphones, or
professional audio gear—but the glitches also happen with built-in speakers and microphones as well as audio devices connected via Thunderbolt.
How often do they happen? Hard to say. Some users see a few every hour, others maybe only one per day.
Many Mac users won’t care. If there’s a little pop while streaming “Baby Shark” for the thirty-first time, it’s not the end of the world, am I right?
OK, maybe I’m right?
However, for others, these glitches are literally showstoppers. If you’re using your Mac to process live audio—maybe you’re a DJ, or a musician
using your Mac to run software instruments with programs like Ableton Live or Apple’s MainStage—blasting your audience with random pops,
clicks, and bursts of sound is a Very Bad Thing. If you are recording music—whether in your bedroom using GarageBand or burning through
hundreds of dollars per hour in a professional studio—those glitches will inevitably happen during critical moments, often destroying your recording.
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Imagine telling a legendary performer: “Hey, that was great, but the Mac glitched.
Let’s go again, maybe it’ll record OK this time!” It’s a quick way to end a career. For
musicians and audio professionals, this problem makes T2 Macs unreliable and
untrustworthy—an irony, since many of these people use Macs to avoid the famous
undependability of audio setups under Windows.
For professional recording studios, the T2 chip isn’t yet much of a problem. (No
joke: plenty of Mac-based recording studios are still using decade-old Mac Pro
towers.) But a tremendous amount of amateur, enthusiast, and professional audio
work—whether music, podcasts, mixing, or DJing—doesn’t happen in professional
studios: it happens on notebooks and in small Mac-based project studios. Plenty of
musicians take their Macs on stage with them to perform in real time. The T2 is
spreading across ever-greater swaths of Apple’s Mac lineup, which makes choosing a
new Mac difficult.
What to do? The T2 audio problems have been known for well over a year, and
Apple has been utterly silent about them save for a vague claim that macOS Mojave
10.14.4 “improves the reliability” of USB audio devices used with T2-equipped
Macs. Some audio developers (like Germany’s RME) have reported A T2 audio glitch captured during recording. The entire
improvements with USB audio, but my limited testing with a T2-equipped waveform should be smooth and uninterrupted. Some
MacBook Pro found no discernible improvement using 10.14.4 with USB or glitches like this could probably be edited, but errors like these
Thunderbolt audio devices.
can destroy a recording.
Some T2 users have been able to reduce the frequency of glitches by killing the
built-in timed process (which synchronizes the Mac clock with a time server) and/or locationd (which tries to determine a Mac’s location for
Location Services). Some folks have had good luck with these workarounds; others still experience problems. Unfortunately, stopping these
background processes is non-trivial and requires disabling macOS’s System Integrity Protection. In other words, not recommended.
Is A T2 Mac Right For You?
For most Mac users, the T2 chip offers clear benefits: not only does it power spiffy fingerprint detection on the MacBook Pro and MacBook Air,
but it also provides fully encrypted storage and hardens the Mac against a range of sophisticated attacks—including the sorts of things that a
government might carry out if one were to seize a computer.
But the T2 also highlights how fragile the Mac world can be. Users who don’t have easy access to an Apple Store or authorized repair shop may
encounter real problems getting a T2 Mac fixed. Users who don’t have a good backup strategy probably won’t be able to recover any data at all if the
T2 chip fails—even if they turn to data recovery experts. And developers who want to run anything but macOS or Windows 10 natively are
basically out of luck. So if your Mac has a T2 chip, figure out in advance where you’ll get it repaired if necessary, make sure you’re backing up
regularly to multiple locations, and stick with virtualization for guest operating systems.
All that said, if you rely on your Mac for audio—whether recording podcasts, DJing parties, or as a professional engineer or musician—I
recommend avoiding T2-equipped Macs until audio issues have been verifiably resolved for quite some time. If you need a new Mac before that
happens, consider one of the few remaining models without a T2 chip, or perhaps an older pre-T2 Mac—sometimes Apple offers a good deal
on refurbished and clearance models.
iWork Update Brings iOS Apps Closer to Parity
by MICHAEL E. COHEN
Just weeks after Apple unveiled new iPads with Apple Pencil support (see “Apple Quietly Releases New iPad mini and iPad Air” 18 March
2019), the company has issued updates to its iWork app suite, with changes largely
aimed at iOS users.
A little history… back in 2013, when Apple completely revamped the iWork
apps, bringing true cross-device document compatibility between the Mac and iOS
versions of the apps, many users were horrified by how many iWork features Apple
abandoned in the process (see “New Free iLife and iWork Apps Share across
Devices and Platforms,” 22 October 2013 and “Why iWork Had to Change
(and What That Has to Do with Aperture),” 9 July 2014). Although most of those
features reappeared slowly over the years, they did so usually first—and often only—
on the Mac: the iOS iWork apps would preserve any content created with those
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features on the Mac, but those apps might not be able to create or edit the same sort of content on their own. However, in the last year or so, Apple
has been striving to make the iOS apps more capable of content creation.
The current round of iWork updates continues that trend, although the Mac and iCloud browser-based apps did get some attention as well.
What’s New with All the iWork Apps
iCloud looms large in the iWork story, and the latest updates expand upon the story. Both the Mac and iOS iWork apps can now:
• Save custom shapes that are shared via iCloud
• Create and share via iCloud document templates or, in the case of Keynote, presentation themes
• Edit grouped objects while collaborating via iCloud
• Create image placeholders (formerly a Mac-only feature)
• Support vertically typed text in text boxes and shapes for documents in Chinese, Japanese, or Korean; Pages provides vertical text support in
the main document as well
What’s New with Pages
Tables of contents are the marquee feature of Pages 5.0 in
iOS and Pages 8.0 on the Mac. Previously, you could create a
table of contents for a document only with Pages for Mac; now
you can not only create them on both platforms but also
navigate and edit them in a new table of contents viewer.
In another major change, the iOS version of Pages has now
gained the capability to switch a document between word
processing and page layout formats, previously a Mac-only
feature.
In addition, the Mac version of Pages now lets you place
alignment guides on master pages to help with layout.
What’s New with Keynote
Both Keynote 9.0 for Mac and Keynote 5.0 for iOS now tout the
unexpected capability to produce animated GIFs by exporting one or more
slides. For the most part, Apple probably intends this feature to make it easy
to publish a self-playing version of a presentation, but users will
undoubtedly find more adventurous uses for it. (That also makes up for the
loss of animated GIF functionality in Preview, see “It’s Frustrating That
Preview in Mojave Isn’t Better,” 13 March 2019.)
As for animations within a presentation, the iOS version of Keynote has
inched closer to the Mac version, and in some ways surpassed it. Both apps
now support action build effects, and in the iOS app, you can create
hand-drawn animation paths, either by using your finger or, on those iPads
that support it, an Apple Pencil.
Finally, Keynote on the Mac better supports extra-wide slides in its slide
navigator, light table, and presenter displays, and iOS users can now edit presenter notes as they rehearse or present a slideshow.
What’s New with Numbers
Numbers 6.0 for Mac and Numbers 5.0 for iOS received the least love in this latest round of updates, with most of the changes polishing
existing features. For example:
• The iOS version provides better support for adjusting row and column sizes with the format pane
• Apple increased the maximum zoom level in Numbers for iOS to 400%
• Smart Categories in the iOS version received unspecified performance and usability improvements
• Both apps received enhancements to their Excel and CSV import capabilities
At the End of the iWork Day
As is nearly always the case, if you upgrade the iWork apps on one of your devices, you should upgrade them on all of your devices. Otherwise,
you may experience interoperability problems or just confusion when new features, such as shared templates and custom shapes, don’t seem to be
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available. Nonetheless, unlike many prior updates to iWork, I have found the previous versions of the iWork apps can open documents created with
the latest iWork apps.
But what about iWork for iCloud, the browser-hosted versions of the suite’s apps? Those apps have been updated too. They now provide the
capability to recover recently deleted files, and they incorporate some of the enhancements of their on-device siblings, such as better Smart Categories
support in Numbers and improved table editing. Nonetheless, they remain second-class citizens suitable mostly for light commenting and
collaboration, rather than full-fledged content creation and editing.
In any case, Apple’s iWork suite has advanced considerably since its 2013 reboot. No longer toys, these free apps have acquired capabilities that
rival those of the most powerful productivity apps available on any platform. If you haven’t looked at Pages, Keynote, and Numbers recently, you
should, especially if you’re an iPad user: iWork has become a powerful competitor in the tablet-based app market, and you certainly can’t beat its
price.
Apple Recalls Some International Three-Prong Plug Adapters
by JOSH CENTERS
Apple is recalling some older three-prong wall plug adapters designed for use in the United Kingdom,
Singapore, and Hong Kong because they can break in such a way as to pose an electrical shock hazard. Apple
included the affected adapters with Macs, iOS devices, and the Apple World Travel Adapter Kit from 2003
to 2010.
The affected adapters are entirely white and have no letters on the inside slot.
The newer, improved adapters are gray on the inside section.
To start the exchange process, contact Apple Support, an Apple retail store,
or an Apple Authorized Service Provider and provide the serial number of
the accompanying device (or just tell them you bought the Apple World Travel Adapter Kit).
This isn’t Apple’s only plug adapter recall—also see “Apple Recalls Some International Wall Plug Adapters” (28
January 2016) for details on a recall for two-prong adapters designed for use in Argentina, Australia, Brazil,
continental Europe, Korea, and New Zealand.

Tidbits

[Click on the blue titles to read the whole story]
Aperture Won’t Run after macOS 10.14 Mojave -- Apple has announced that its obsolete professional-grade photo manager Aperture won’t run
in the next major release of macOS after Mojave. If you’re still using Aperture, start planning your switch.
Vector graphics app Vectornator gets redesign + new features after going free — After making its pro version free for all last year, popular vector
graphics app Vectornator this week launched one of its biggest updates yet and it remains entirely free for current and new users.
How Rogue YouTube Employees Killed Internet Explorer 6 -- Early YouTube employee Chris Zacharias has shared the story of how he and a
rogue team of developers bypassed Google’s bureaucracy to put a stake through the heart of Microsoft’s Internet Explorer 6 Web browser.
The Productivity Pit: It’s the People, Not the Tools -- Real-time workplace communication tools were supposed to improve productivity, but
they all too often have the opposite effect thanks to too much chatter.
Amazon Workers May Be Listening to Your Alexa Conversations Bloomberg has revealed that Amazon pays people to listen to a subset of
Alexa recordings for the purpose of improving the technology. Do you trust Amazon with recordings of everything you say within an Echo’s
earshot?
Disney Pulls No Punches Going after Netflix -- Disney has finally announced the details of its upcoming Disney+ streaming service, which will
offer a breathtaking amount of old and new content for a mere $6.99 per month. How will Netflix respond?
Apple Cuts HomePod Price to $299 -- Apple has permanently lowered the price of its HomePod smart speaker by $50, from $349 to $299.
Was it just overpriced or is Apple clearing the decks for a new model?
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A Close Look at the Titanium Apple Card’s Design -- Designer Arun Venkatesan has published a detailed study of the physical Apple Card, due
later this year. A lot more thought has gone into it than you might have realized.
Netflix Removes AirPlay Support from Its iOS App -- Netflix has removed AirPlay support from its iOS app, citing “technical limitations” that
outside observers suspect have more to do with the competitive landscape than anything else.
Considering a Smart Doorbell? SkyBell HD Reviewed -- A number of video doorbells are on the market, but at the moment, none work with
Apple’s HomeKit. A couple of companies announced future support for HomeKit and more products were announced at CES. But is HomeKit
really critical for a doorbell
Apple and Qualcomm Settle Patent Royalty Suits and Agree to Licensing -- After years of patent battles, Apple and Qualcomm have suddenly
dropped all legal action and are now partnering up again, with Apple paying Qualcomm an unspecified licensing fee. Intel dropping its 5G modem
development was probably related.
Charging an Apple Pencil Can Keep You From Unlocking Your Car -- In a strange twist, the second-generation Apple Pencil’s charging
mechanism can interfere with car key fobs. Luckily, it’s easy to avoid the problem.
Apple Drops $99 Data Migration Fee for New Macs and Repairs -- Apple has dropped the $99 fee that it previously charged for migrating data
from an old Mac to a newly purchased machine. TidBITS reader and TekBasics consultant David Price wrote to tell us that he has generally
advised clients to pay Apple to migrate data to newly purchased Macs, but when he accompanied his brother-in-law to pick up a freshly migrated
iMac last week, Apple informed him that there was no charge for the service.
I contacted an Apple Store Operations Specialist, who confirmed the policy change:
Beginning April 2, there will be no cost for Data Migrations with the purchase of a new Mac or Data Transfers with a repair.
So there you have it—if you’re buying a new Mac at an Apple Store, or having a repair done that requires moving data, Apple will do it for you for
free. That said, it will still be a slow process, so take that into account when planning your pickup. Also, since the policy just changed, it’s worth
confirming with the people you’re working with if you’re getting Apple to do a data migration soon.
Of course, migrating data from an old Mac to a new one isn’t particularly difficult on your own either, and Apple provides an overview of the
setup process.
How To Find the Best Deal on Digital Movie Rentals
by GLENN FLEISHMAN
More options for digital movie rentals exist now than ever before, but they’re surprisingly uniform in price and duration. Yet, it’s still worth
shopping around to find a deal: either pay a buck less or get more time to watch a movie after starting playback instead of the usual 48 hours. In this
article, we’ll look at rentals from iTunes, Amazon Prime Video, Fandango Now, Google Play, Redbox on Demand, Vudu, and YouTube. (We
wrote about finding deals when purchasing movies to own last year, in “Use Movies Anywhere to Take Advantage of Bargains,” 31 August
2018.)
You may also find that you prefer or dislike a particular service’s user experience, whether you watch in an Apple TV or iOS app, an app on your
smart TV or another device, or in a Web browser. That can shift your usage, too. Most services have an Apple TV app, but some require AirPlay
streaming or an app on a smart TV.
I can cut to the chase with the two best takeaways, however:
• iTunes is the only service that lets you rent movies directly in apps on your Apple devices. Because of Apple’s 30% cut, all competing services
require a rental payment via a browser (sometimes only a desktop browser) or a non-Apple device.
• YouTube almost always gives you 72 hours from when you start to watch a movie to finish it, as opposed to every other service’s 48 hours. A few
rental sites allow only 24 hours.
If you routinely watch movies on a variety of devices or prefer your smart TV’s built-in or add-on apps for streaming, I get into the nitty-gritty of
device support and best deals below, including some recommendations for free options.
Rental Prices and Time to Watch Are Similar Everywhere
A few years ago, there was more variation in pricing, but studios and services appear to have harmonized. However, it’s always worth looking for
sales and deals, as these occur regularly, and often mix up relatively new films with classics. Many sites have $0.99–$2.99 HD rental pages that
update periodically.
To check prices, I looked at the recently released Aquaman on several services along with Tron Legacy from 2010. Aquaman cost $5.99 nearly
everywhere. Only Redbox on Demand offered an SD version for a buck less at $4.99; all the other services charged the same for SD and HD, or
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listed only HD and 4K. Meanwhile, Tron Legacy was $3.99 in
HD and $2.99 in SD on all services. (All the services I checked
charge sales tax in Washington State, too; I assume that’s true
in every state with sales tax given a 2018 Supreme Court
decision.)
Nearly every service had the same period of rental for both
movies as well. From the time you check out, you have 30 days
to start watching. With Aquaman, you then have 48 hours
during which you could stream the film at nearly every service,
even on YouTube. Vudu was the odd one out with just a
24-hour screening period.
Tron Legacy also limited viewing time to 48 hours
everywhere except at YouTube and Google Play, where you
Aquaman costs $5.99 in HD everywhere, whether at Amazon Prime Video (shown)
get 72 hours. Why would you want 72 hours? For the same
or another service, typically for a 48-hour viewing period.
price and quality, it’s worth another 24 hours if you don’t
think you can get through the whole movie in a single night—
an issue if you have kids or it’s one of the increasingly common
2.5- to 3-hour movies now being made. (Google Play appears
to have the same time-to-watch period as YouTube rentals, but
less device support for playback.)
When I spot-checked other movies, I found that Amazon
Prime Video offers 72 hours to watch some films, but nowhere
near as commonly as Google’s services.
Each site is a little particular about where you can play back a
movie, which might affect your purchase choice as well. Macs
don’t allow HD playback on external monitors from a Web
browser, which might be a factor depending on your setup.
Here are the possibilities:
• iTunes: Apple TV, iOS, and macOS via iTunes. No
browser-based playback. (In the future, some smart TVs
will have an Apple TV app, however: see “Apple Opens
iTunes Video and AirPlay Up to TV Rivals,” 9 January
2019.)
• Amazon Prime Video: Browsers; iOS, Android, and
Fire tablets; Apple TV, Fire TV/Fire TV Stick, Roku,
YouTube (and Google Play) typically oﬀer a 72-hour viewing period for
TiVo, and others (no Chromecast support); many smart
everything but the latest releases for the same price as 48 hours at other
TV and connected Blu-Ray models; PlayStation, Xbox,
services.
and Wii. (Amazon still hasn’t updated its support page to
include Apple TV.)
• Fandango Now: Browsers; iOS and Android; Chromecast and Roku (Apple TV only via AirPlay); most smart TVs and game consoles.
• Google Play: Browsers; iOS and Android; Android TV, Chromecast, and Roku (Apple TV only via AirPlay); LG, Samsung, and Vizio smart
TVs.
• Redbox on Demand: Browsers; iOS and Android; Apple TV, Chromecast, and Roku; LG and Samsung smart TVs.
• Vudu: Browsers; iOS and Android; Apple TV, Chromecast, Roku, and TiVo; LG, Samsung, and Vizio smart TVs; Playstation, Nvidia, and
Xbox consoles; LG, Samsung, and Sony connected Blu-Ray players.
• YouTube: Browsers; iOS and Android; Apple TV, Android TV, Chromecast, and Roku; many 2013 and later smart TVs; Xbox and
PlayStation.
If you have a 4K TV and appropriate hardware to play back UHD/4K movies, you’ll need to dig into requirements further. Every service seems
to have provisos and footnotes about device support, and some don’t guarantee that every UHD/4K movie will play on every device because of
licensing limitations. UHD/4K versions of movies may also offer less time to watch after a rental starts, which seems an odd quirk.
Your most reliable and consistent option for UHD/4K in the Apple ecosystem is almost certainly iTunes and an Apple TV 4K connected to a 4K
display (but see “The Apple TV 4K’s HDR Nightmare,” 13 March 2018). However, if you have a 4K smart TV or a 4K streaming box from
another company, you can certainly explore other options. Every service has a way to request a refund if a movie doesn’t play back as expected.
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Note that some services won’t let you rent at HD or UHD/4K on devices that don’t support those resolutions. So you may need to rent using the
right device, too, or you can wind up paying the same amount for a lower-fidelity version of a movie than the hardware of the device you want to
watch it on can support!
The Best Ways to Rent or Watch
All other things being equal, here are my suggestions for the
services to try, in order, with some usage tips:
• iTunes: You can often find iTunes Store gift cards on sale for up
to 20% off the face value, especially around holidays. That’s a
nice discount if you don’t need more than 48 hours to watch a
film. (Follow the unofficial iTunes Card Deals on Twitter for
bargains.) For Apple ecosystem folks, iTunes remains the best
option, though YouTube is a close second.
• YouTube: It takes a little extra effort to rent and watch a movie
with YouTube, but that extra 24 hours for most films can make
Renting a movie in iTunes on the Mac requires confirmation, though you can
it worthwhile. Start in a desktop Web browser (not Safari for
opt to rent with a single click in the future by checking a box.
iOS) at YouTube’s movies and TV page, search for the film you want,
and rent the resolution you prefer. Now, close the browser window if it’s
anywhere near your TV, as YouTube starts to show distracting previews.
You can proceed to watch the film in iOS or with an Apple TV. Finding
your rental is a little hard in YouTube’s Apple TV app: swipe right to get to
the vertical navigation bar, swipe down to the folder icon, then swipe right
and then down to the Purchases item. The recently purchased rental
appears as the first item at the upper left. The rental period starts when you
click the play button.
•Amazon Prime Video: For those with an Amazon Prime subscription,
the e-commerce giant offers a huge number of TV shows and movies for
Playing a movie in YouTube’s Apple TV app requires renting in a desktop
browser and then a little navigation.
free viewing, including some original content. If you have a
subscription, always check the site first to see if the movie you
want to watch is available at no cost: go to the Amazon Prime
Video page while logged in, and the site shows it as “Included
with Prime” if it’s free for Prime subscribers. (You can also browse

Movies and TV shows included with an Amazon Prime subscription show
the “Included with Prime” label and have a Watch Now button with no cost
displayed.
a list of all movies and TV shows available for free.)
•Vudu: Vudu offers nearly 4000 movies you can watch for free with
interruptions for advertising. The titles vary from low-brow teen skin flicks to
top-notch offerings that did well at the box office, such as the original
Paddington, An American Werewolf in London, and Platoon. They do require
that you watch a lot of ads, though.
While digital movie rentals might seem like they’re available at the same price
and under the same terms everywhere, a little digging can save you a buck or
Vudu offers an extensive catalog of movies you can watch at no cost with two, buy you an extra day, or deliver a better experience.
ads. Many of the films are straight-to-video or poorly reviewed, but there
are a lot of winners in there, too.
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Can’t wait for the next newsletter to see what the guys and gals at Joy of Tech are up to? Then simply go on over to their
website and see past and current cartoons and other things
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HOW TO FIND US
General meeting:
SMMUG General Meetings are held on the SECOND Monday of
each month at Fire Station 14 located at 1875 Dublin Blvd (at the
intersection of North Academy and Dublin).
Directions:
From Academy, go east on Dublin and then turn right on
the very first street. There is parking on the west and south
sides of the Fire Station (with additional parking located to
the north and further west of the Fire Station). The entrance
is on the west side of the building.
Smoking is not permitted on the premises.

Sig meeting:
The SIG Meetings are held on the SECOND Saturday of each month at the CityMac store located within the University Village Shopping
Center at 5020 North Nevada. CityMac sits right next to the Xfnity Office and is across the street from Costco.
Directions:
Take I-25 to Garden of the Gods Rd. heading East. Turn left on Nevada and then left on Eagle Rock Road. Drive past two
intersections and then park on the left in front of the CityMac Store
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About Us
The Silicon Mountain Macintosh User Group, Inc. (a nonprofit educational corporation) was formed in Colorado Springs,
Colorado in 1985, and is one of the oldest Macintosh User Groups in the United States. SMMUG, Inc. is dedicated to helping
members enjoy and learn about their Macintosh computer, iPhone and iPad devices.
Club membership is open to everyone and you are cordially invited to visit our free monthly General Meeting on the second
Monday of each month, at 7:00 PM. For those new to the Macintosh, we have a Question & Answer session at 6:00 PM, where
our collective expertise can help answer your questions.
All members receive a monthly newsletter, published on our web site, see great reviews of software and hardware, or can
participate in the monthly door prize drawing. Each member gets one vote during annual Oﬃcer Elections. No corporate
memberships are granted.
Our oﬃcers are volunteers and receive no pay. All funds raised are used for the cost of operating the club and its meetings.

Membership Application Form
Membership entitles you to access to our online forums, participation in prize drawings, and access to the
bargains in the members area of the SMMUG website at www. smmug.org. SMMUG renewal membership dues
($30) apply to the calendar year and are paid each December for the following year. Use the following table for
NEW MEMBERSHIP ONLY:

JAN 1 to MAR 31 - $30.00
JUL 1 to SEPT 30 - $15.00
Please Print Clearly!
Name
Street Address
City/State/ZIP
Home Telephone
E-mail Address
Have you previously been a member of SMMUG?
How did you learn about SMMUG?

APR 1 to JUN 30 - $20.00
OCT 1 to DEC 31 - $10.00
Today’s Date

Business Telephone

Make your check payable to: SMMUG
Then mail or give this form and your check to:
SMMUG, Inc.
2100 Wood Avenue
Colorado Springs, CO 80907-6718

Please make an online account for me.
User Name _______________
Don’t make an online account for me.
I do not want one or I already have

